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3.

What is DNS Poisoning in the context of
computer security 7
(A} Intentionally corrupting data on a
hard drive
) Injecting false information into the
Domain Name System (DNS)
(C) Encrypting network (raffic  for
privacy
(D) Improving the speed of internet
connections.
What is the primary goal of phishing
attacks in cyber security 7
(A), To gain unauthorized acceéss 1o
,  computer networks
(B} To install antivirus software on user
devices
(C) To spread awareness about online
security

VLD".I To trick individuals into revealing

sensitive information
What does MOOC stand for in the context
of online education ?
+ Massive Open Online Course
(B) Modern Online Qutreach Curriculum
(C1 Maobile Offline Orientation Center
(D} Multimedia Oriented Online
Collaboration
What does OCR stand for in the field of
document  processing and  computer
vision
\,M/J- Optical Character Recognition
(B) Online Communication Resolution
(Cy  Overlapping Character Rendering
(D} Object Classification and Recognition
Which of the fuilnwing can be considered
as e-Governance services 7
\L:‘(]I Driving License
{(B) Driving Car
(C) Buying Vegetables
(D) Printing T-Shirts

FEH g F e § DNS wizsfin # #n

wIE?

(A) BIE gEa W 271 F FEEEEl

(B) E#A 48 fawyg (DNS) § meg s
m i

(C) Fza 2fes i idraan & fo ufsre
HAT

(D) F22 FA%9E 1 7fF § U7 F7

wEE? e | fetem zuel %1 vgm way e

22

(A) FHA FeadH 1 FAUFd B9 wd

L

(B) IS IUF T UHaraTy gieed
zepfog &

(C)  #Aemea gien & @it § srreswar Hem

(D) =il 1 dagavite FHEE T3 w3
¥ fgamae w1

e i % Had § MOOC &1 #1514

%7

(A) BfEs 59\ Afaerzg #d

(B) ®fed e e Fiiwem

(C)  Hramsw sFeE Afieye dvar

(D) wedrifem sifride sifaemes geam

TS YR 3 F: 9 5fe & &5 8§ OCR

FFN adE 2

(A) ffess S frefaee

(B) ATAENE HaR gaer

(C) siarafon iy Tefin

(D) ffsdae Fenfafrsye ain fraefaes

Trefefaa # 4 7 £ 7eqs daed & =0 §
HIA A B 7

(A) Zrzfam sde

(B) =N I

(C) wfesgi wie

(D) &-92 fie o
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6.

What is the shortcut key for opening the
task manager in Windows 7

(A)Y  Col+Al+Del

&B’}r— Curl+5Shifi+Esc

(C) Ali+F4

(DY Cul+Tab

Google Drive. Microsoft One Drive and
Drop Box are the example of :

(A) Operating System
(B} Search Engine
() Network Topology

.__LH{ Cloud Storage Services
Suppose obtained marks of each paper are
in B2 to B7 cells. Maximum Marks are
1) for each paper. What is the correct
formula to calculate percentage in MS-
Excel 201010 %
=SUM(B2:B7 y/600% 100

(B) =600 1HIKWSUMIB2:BT)
() =0BTAIN(B2:B7)600* 100
(D) All of these

If you add a recipient email address in

ceeemies box of an email message. copy
of the message is send to that recipient and
recipient name is not visible 1w other
recipients of the message.
(A) To (B)

J,E“] Bee (D

Cc
Subject

10. DNS service must translate ...

11.

into the corresponding ... ;
(A) IP address, Domain name
} Domain name, [P address
(C)  Client. Server
(D} Folder, File
Which of the following services can be
availed through the e-Mitra portal ?

(A) Bill payment
Application for certificates
(C) Filing of grievances

&

All of these

(3)

10.

11.

faers d ere BAe Wi # widEwe da #
T ?

(A Cul+Ali+Del
By Cul+Shifi+Esc
(C)  Al+F4

(I Crel+Tab

T gEd, HEEER 51 gEa o gy At
THE T E

{A) =gz fa=n
(B) @HEaA
(C) FZas Zrersn

(D) #Frse Wi Jand :

A wifae fe g9 9w & W B2 § R
cu!%sﬁ%1mﬁ%mm-ﬁlllﬂ
% uqTE-TEgE 2010 4 wiaye Fuffm a0 &

(A) =SUM(B2:B7)/600%100
(B)  =600*100/SUM(B2:BT)
(C)  =0BTAIN(B2:BT)600*100
() & @ : :

ofg 39 T 0 R #
i e Higd B, @ T2 &1 wfa 2 wraeal #
TR 2 W # i uraEdl 1 A =I5 9
e #1 faan A9 g R

tA) To By  Cc

{C) Bce (D)  Subject
FLUATH. (DNS) T .o, 1 Haftra
ceesrsrinnes B STETE WA B

(A) S @, EEA AW

(B) BIa A19, e Ia

(C) FeEe, Tt

(D) THITEL, HEA

2oz 9= % wragm | frefefag 4 9 9
Hanad & =0 S9N Heha ¥ 7

(A) T ya

(B) wHW 93 % fom stmeEA

(C) forraa ad &0

(D) & 9
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12. What is the shortcut key
document or windows ?
(A} Cul+O (B} Cul+S
JE Cul+N (D} Cul+P
Which service can be used through S50
Portal Resident’s Login ?
(A} E-Mitra Services through Web Portal
(B} Rajasthan Sampark
(C)  e-Public Distribution System

D) All of these

14. Which is the example of E-Commerce

for opening a new
paek

13.

websile ? .
(A)  Twitter {B) Facebook
) Amazon (D) All of these
15. Following is the comrol groups in

Animation Tab of Microsoft PowerPoint

2010 :
(A} Preview (B} Animation
(C)  Timing m{ All of these

16. Following are the elements of a Chart in
MS-Excel 2010 :
(A)  Chart Title, Legend. Data Labels
(B)  Data Points, Data Series, Gridlines
() Value Axis. Category Axis

All of these
Which of the following is an Open Source
(free to all) Mobile OS ?

1.

(A} Windows Phone OS
(B) Apple 08
(C)  Both (A) and (B)

I None of these
18. What are the uses of Snap Assist in
Windows 1) 7
(A) To take a snap
(B) To ke screen shot
N1 4] Making multiple windows run on
ONe screen
(D) All of these
It you want row/column to repeat on all
pages during printing in MS Excel 2010,
you can use ;
(A)  Page orientation
(B) Page size
€T Print titles

(D)} Scale to fur

19.

(4)

12

15

14,

16,

17.

18.

19.

7 a.mr-‘: FI_E :_-I "E‘;‘
j
B 5

(A) Cul+0 (B)  Curl+S

iy CuleN (DY  Crird+P
THTH UdA fard o F mean 4 fag
a1 1 9 T W g 2 7

(A) &3 9 & gromm § ¥ -fqg dand
(B) A% qus

(C) E-wrdsfas faqmm yoreh

(D) 3 g+

 Fiad FAUEe F1 S0 =R E 7

(A) femex (B) HHE®
(C) s (D) 33
. WIS afErdiiE 201 0% v 2 1 fsm
(A)  gEEEEA (B) wHtEm
(C) Hug (D) & av

%m A 2010 & U =2 F ae FrAfefad

(A} =2 ¥id=, =i, 227 Faw

(B) 221 offew, 2= iy, fremme=

(C)  Frg ufprm, $2m ufesm

(D) 33w

faetferfan & & 9 uF simm o9 (o &
fere 1 310 ) Hrmzer sim & 7

(A) fagra v sims

(B) w9 amgie

(C)  (A) 3 (B) =

(D} 98 4 #rE F

faers 10 § Snap Assist ®1 Fu1 I7Em
£ ?
(A) =9 &3 # fom
(B) T ¥z &9 & fom
(C) TF &AW v § sifus f68 @ wam
(D) & Bt
afg 3 uHTE vRdE 2010 § fifin & dam
|l Je3i 07 afa /e S = § 9 e
THE] TTAM FT B 2§ .
(A) 97 sifrazes
(B) W &gy
(C) fue zmeew
(D) A z fee
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20. What is the default file extension for a

Microsoft PowerPoint 2010 presentation ?

v?ﬂ PPtX (B) .ppt
(C)y .pptm (D) .pps
21. How can you apply a custom animation
to an object in a PowerPoint 2000 slide 7
) Right-click on the object and select
"Custom  Animation”  from  the
confext menu.

(B) Go 1o the Animations tab in the
ribbon and choose a preset
animation from the gallery.

(C) Select the object, then press Cirl+A
to open the Animation pane.

(D} Use the Format Painter o copy
animation  settings  from  another
ohject.

22. Designed and launched by National

Payments Corporation of India ?

A} Rupay iB)  Muster

(€} Visa (D) Mestro

23, In Excel 2010, which function is used to
find the highest value in a range "
) MAX( ) {B) HIGH( )
(C) TOP{ ) (DY PEAK( )
24, Which are the major e-Governance

Initiatives in Ruajasthan 7

{A) Raj Megh

{(BY Raj Net

(CYy Raj Sewa Dwaar

S All of these
25. The full form of '‘BOCCT used in e-mail
communication is

(A} Blue Carbon Copy

M) Blind Carbon Copy

(C) Black Carbon Copy

(D} Back Carbon Copy

set-C )

20.

i2.

24.

25.

HrEEETE ETrEE 2010 weEf # fau fewie
HTEE THRTYA FE 2

(A) .ppix (BY .ppt

(C) .pptm (D) .pps

. TETOiEE 2010 T=Es § s s T F52g

WHTYE # w7

(A} e T e Feer Hifan dr wieee
¥ 8 @ AT & =9 i |

(B) T d wAyA 2| W wEu oW e @
#1¢ gty weidys g

(C) sz =1 wfu, fry wiive i s
# & Curl+ A Tamem |

(D) Wi 2y %1 audm S wfhee afdm
= gt e § i i)

WA & T A e g e s s
o 7 7 -

(A} Rupay (B)y  Muaster

(Y Visa (DY  Mesiro

. UFETE 2010 3, e wee & 3wim e 1 gea

i 7o gt = fom e o & 2
{A) MAX( ) (By HIGH( )
(C) TOP( ) (D) PEAK( )

(A) T=HY

(B) THH2

(C) T = gR

(D) & 99t

£ T =i § Wi A6 9 CBOCT & fawfia
g

(A) & &ra i

(B) eSS e it

(C) =% SreA Hid

(D) s WA H
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26.

7.

28.

29,

30.

&1 Cul+l (D)

What is the keyboard shortcut for opening

the ‘Format Cells’ dialog box in Excel

2010 7

(A} Cul+F (B Cirl+Al+F

Curl+Shift+F

What does the "VLOOKUP' function in

Excel 2010 do ?
Searches for a value in the first
column of a range and returns a
corresponding value in the same row
from another column.

(B) Calculates the sum of a range of
cells.

(CYy Counts the number of cells in a
range that meet a specific condition,

(D) Multiplies the values in a range of
cells,

Which ribbon tab in Microsoft Waord 2010

contains the commands for formatting text,

changing fonts and adjusting paragraph

settings 7

)} Home (B)

(C) Page Layout (D)

How can you insert a page break in

Microsoft Word 2010 7

(A) Press Enter key multiple times.

) Go to the Page Layout tab and click

on ‘Breaks’ then choose “Page’.

(C) Press Curl+P.

(D} Use the Insert tab and select “New
Page’ from the options.

What is the purpose of the ‘Find and

Replace’ feature in Microsoft Word 2010 7

(A) Change the font style of selected text.

\_[,B'Y Search for specific words or phrases
in the document and replace them
with new text. .

(C) Insert hyperlinks into the document.

(D) Adjust the line spacing of the entire
document. '

Insert
References

Set-c

26.

27,

28.

29,

(6)

THE 2010 #  C‘wide #@ew'  Ergem
TFFH Amd & fou #EE widss @
%7

(A} Cul+F (B) Cirl+Alt+F
(C) Crorl+1 (D} Curl+Shifi+F

THEE 2010 § VLOOKUP' %991 #1 #g
FIAE ?

(A) % T8 & vgd Wy § um §ey
® WS w E oA 3 dfsm &
ot = 1 afa 5o # s 2
(B) @&l = UH W w1 g wa E

(C) wk I9 4 uw fafere fufs =1 g0 #05
et Hel 1 EEE] O] i

(D) & =1 v 5§ g w1 qon w5 E

HIFIETHR 92 2010 3, =gt fram 79 § 2=

&1 TEYA %17, Fi= 726 30 Tunrs e

1 FAMETE F11 # RV ER E ?

(A) 2 (B) =W

(C) 9 ez (D} TEiEY

UEHIETR g8 2010 § U9 e 4 2en wm

HFEA & ?

(A) U2t Kt F FE A6 ZaE |

(B) U Hew3z 28 W ey o9 e W faee
Fifau, fee ‘U= gf

(C) Cul+PEemEe|

(D) T92 29 &1 39dEm Fifau o faweyi 4
' U9 w1 =9 wifan

. R 7€ 2010 # Wiz ol from giE

F W ANR ?

(A) =40 92 1 W2 WEH g50T |

(B) Te=eyg # fafime w=si =1 =
1 @I HE 3 I A0S E awe

(C) T=meg H grguifeis e

(D) ¢ =wmds w1 ifF (@A) w@fEn
R =
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31. In Microsoft "Word 2010, how can you

create a numbered list 7

{A) Press the Tab key at the beginning
of each line.

(B) Use the Bullets button on the Home
tab. o

(Cy  Select the text and choose the "Line
Numbering” option from the Layout
Tab.

\[})1/ Click on the Numbering button
under paragraph setting on the Home
tab.

32, What is the primary purpose of a web

browser 7

(A) Sending e-mails

(B} Playing online games

Jff Browsing websites on the internet

(D) Creating documents

33. In Microsoft Excel, what shortcut key

combination is used (o insert a new

worksheet 7
(A) CurleN By Cul+W
M Cirl+ShifteN (D) Cul+Al+W

34. In Microsoft Outlook. what is the shortcut
key for creating a new e-mail 7
{A) Curl+N {B) Cirl+E
w’}/ Cerl+M (DY Cul+Shift+M
35. What is the purpose of a restore point in
Windows ?
(A) To create a backup of personal files

__;BT To revert the system to a previous
state in case of issues

(C) To upgrade the operating system

(D) To install new software applications

(7)

32.

3s.

. AEwErE 5€ 2010 #, 39 £8 s deifEa

et w1 A E 7

(A) Ve UfE F IEAE § 29 we ganent |

(B) &M 24 T g8 924 1 940 F4 |

(C) W8 &1 FAHT A A2 2| F 'EnEd
Faftn’ fawea #1297 =35 |

(D) ¥M 39 W s Afen & qed TWin

w2H T faE i |
U 99 WI9H # e Ry a7
(A) 0ot
(B) affaeimsa @e "o
(C)  F2T92 U1 FwHEE F3s A
(D) FEwES =

. WG T §, T gt T & fe

FIAH vidwe A T fwm w7 2
(A} Cirl+N By Cul+W

(C) Cul+Shift+N (D}  Cul+Al+W

. HIEEHEIGE S A AU $he 99 & fo vitdae

wA FNE ?
(AY Cul+N {By Ctrl+E
() Cul+M (D) Cul+Shifi+M

fagmdus frEn vz s ®ya ¢ ?

(A) AT FEE! 1 AT 79 & fag

(B) fowew = aeeaii & wras # foee frafa
# grareHt #39 % fog

(C) sraifin famw =1 avire #33 = fag

(D) U AigEE HIEm w4y F % fo
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10.

11.

Set-C

Four alternative answers are mentioned for
each question as (A}, (B}, (C} and (D) in the
Question Booklet. The candidate has to
choose one correct answer of the question
and mark the same in the OMR Answer-Sheet
as per example given below :

For Example ;
Question :

1. @ ® © ©
2. @ ® @ ©

lllegible answers with cutting and over-
writing will be cancelled.

In case the Candidate does not fill the
appropriate circle in the Answer-Sheet and
leaves blank, ‘Zero’ mark will be given.

The candidate has to mark answers carefully
as per instructions on the OMR Answer-
Sheet with black or blue ball point pen only.

Strict instructions are hereby given to the
examinee to refrain from correction of their
earlier marked answer in OMR by rubbing or
scratching or using white fluid, In case of
violation of this instruction, examinee's
result may be detained or the examinee may
be declared disqualified in the exam.

The examinee shall hand over original OMR
Answer-5heet to the invigilator and can take
carbon copy of the OMR Answer-Sheet and
Question Booklet with himself/herself.

Write your Roll Number and other required
details in the space provided on the title
page of the Question Booklet and on the
OMR Answer-Sheet with ink pen or ball pen.
Do not use lead pencil.

To bring and use of log-book, calculator,
pager and cellular phone in examination hall
is prohibited.

All the questions are bilingual. In case of any
discrepancy the question in English version
shall be treated as correct.

(Jan. - 2024)
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4,
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11,

vA-Tfms # v&@% 99 & wn genfan s
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1 faderan fafga =1 | 397 %1 OMR 39 795

¥ wEfaE g9q Hiem | e gwn Wi
TR -

e

1. @9 & © @

2 ® ® @ ®

srafad T o U I T = o =men o #
frreg = fod) s

afz wfiend OMR 397-93a § I9%F Tl #
FE A & A OMR 397- 9% &1 HE B g
2@ v ey T e

sl &1 U¥Al % I OMR 39T -Us&h T S99
#H A A Al e WA R sifea
=HTA B |

gdee 1w fEw fae em E R w9 o
OMR 771 -93% 8 7 & fou o oo 1 weed 2
o faer o #1e3 % fou Ahe 2| &1 Joam
7 H1 ) 37 T8 = e %1 9 A
afienet @1 aftong 1 o wam B o 28 when §
FAy Hifwg & o 6@ 7

witgre w witen waT grgd @ ud OMR
T -uA (9 uf) sifard v w wa Pritees
o UTH FUT A B TGT OMR 9T U5 il
aTel ifer e Wy - et 370 AT A we
%l

99 YR & 93 U 9 A9 OMR I9T-UAeE
w1 fauifia T § sweE ag 2= faarw &%
oA EE: w g A o e srwgm e
|
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